
APN and MMS Settings for SimpleMobile

  Android (MY Touch, G1, MOTO Cliq & Behold 2) - Internet
  Internet  
    1. Press the menu.  
    2. Tap Settings.  
    3. Tap Wireless Controls or Wireless & Networks..  
    4. Tap Mobile Networks.  
    5. Check that:                    
    -  "Data Roaming" and "Use Only 2G Networks" are both unchecked.  
    -  ETap Access Point Names.  
    -  Press the menu button.  
    -  Select New APN.  

    

  
    1. Name: Simple Mobile  
    2. APN: simple  
    3. proxy: 216.155.165.050  
    4. Port: 8080  
    5. Username: [empty]  
    6. Password: [empty]  
    7. Server: [empty]  
    8. MMSC: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  
    9. MMSProxy:[empty]  
    10. MMS Port: [empty]  
    11. MCC: 310  
    12. MNC: 260  
    13. APN Type: [Not set]  
    14. For Samsung Behold II press #*87927#  

               Apple iPhone - Internet and MMS
  The reason the iPhone can not receive full 3G on Simple Mobile is  because Simple is a
T-Mobile MVNO: Mobile Virtual Network operator in  other words they use T-Mobiles airwaves
to provide the service and they  run on different 3G frequencies. NOTE: Make sure that you
phone is fully  unlocked and 3G service is OFF on the phone.

Instructions:
Navigate to "Settings = General = Network = Then Cellular Data Network insert these settings
bellow

Under Cellular Data:
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APN: simple
Username: *Blank*
Password: *Blank*

Under MMS:
APN: simple
Username: *Blank*
Password: *Blank*
MMSC: http://smpl.mms.MSG.eng.t-mobile.com/mms/wapenc
MMS Proxy: None
MMS Max Message Size: 307200 which is 300kb

all done now
Method #2 The  easy way is to add the Simple mobile Fix  package  from cydia. I personally
had a good experience with them, you can get the packages here
Go to Cydia then Manage then edit - add source:
http://beta.leimobile.com/repo/
Download "Simple Mobile 4.0 MMS Fix
this file also writes a plist file. This is the best way to fix your mms and internet.

               Quickfire - Internet and MMS
  Internet Part 1  
    1. Press MENU.  
    2. Press SETTINGS.  
    3. Press PHONE.  
    4. Press NETWORK PROFILE.  
    5. Press ADD.  
    6. Title: Simple  
    7. Username: Blank  
    8. Password: Blank  
    9. APN: simple (lowercase)  
    10. Press SAVE two times then press END CALL.  

Internet Part 2  
    1. Tap SETTINGS.  
    2. Tap APPS.  
    3. Tap BROWER SETTINGS.  
    4. Tap ADD.  
    5. Tap ENTER NAME: Simple  
    6. Hit DONE.  
    7. Home: http://www.google.com/  
    8. Hit DONE.  
    9. Proxy Address: 216.155.165.50  
    10. Port: 8080  
    11. Network Profiles: Select Simple and press Activate.  
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Internet Part 3  
    1. Tap MENU.  
    2. Tap SETTINGS.  
    3. Tap APPS.  
    4. Tap MSG SETTINGS and then MULTIMEDIA MESSAGES.  
    5. Tap MSG CENTER.  
    6. Verify the following:                    

  
    -  Name: Simple MMS  
    -  MMSC URL: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  
    -  MMSC Proxy: 216.155.165.050  
    -  MMSC Port: 8080  
    -  Network Profile : Simple (drop down list)  

    

  Blackberry - Data Connectivity (without BIS services) MMS not supported
  

Note: You must download a 3rd party browser to access the internet (see steps below).

  Setting the APN  
    1. Select Options or Settings and then select Options.  
    2. Select Advanced Options.  
    3. Select TCP (Option will say TCP/IP on OS 4.6 and higher).  
    4. If applicable, check mark the APN Settings Enabled box.  
    5. Enter simple as the APN. Ensure no entries in the username or password fields.  
    6. Click the back arrow and then select Save.  

Delete any existing Carrier Service Books  
    1. Select Options then select Advanced Options.  
    2. Scroll down and select Service Books.  
    3. Delete any listings for [browser configuration].  
    4. Back out and save the changes.  

Opera Browser Download and Installation from a Blackberry Wi-Fi Connection:  
    1. Select the Manage Connections icon.  
    2. Checkmark the Wi-Fi checkbox.  
    3. Select Setup Wi-Fi.  
    4. Select Scan for Networks.  
    5. Connect to an available network.  
    6. Open the Browser icon.  
    7. Select Go to from the Blackberry menu key and go to http://mini.opera.com (NOTE: If the
browser still says no network connection press the menu button, select Options-General, and
switch to the Hotspot browser.   
    8. Download/install the Opera Mini browser.  
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    9. Once installed, power cycle the Blackberry.  

Opera Browser Download and Installation from a personal computer (make sure the
Blackberry Desktop Manager software is installed):  
    1. Go to http://www.opera.com/mini.  
    2. Click the Download Opera Mini link.  
    3. Select your Blackberry model from the drop-down list.  
    4. (Note: If you don't see your specific Blackberry model, choose Opera Mini generic)  
    5. Follow the prompts and download the software to the desktop.  
    6. Right-click the downloaded software and select Extract All (a new, unzipped folder will
appear on the desktop).   
    7. Plug the Blackberry in to the PC via USB cable connection.  
    8. Open the Blackberry Desktop Manager.  
    9. Click on the Application Loader icon.  
    10. Click the Browse button and browse to the downloaded and unzipped folder and then
select the operette-hifi-en-us-nojsr75.alx file.   
    11. Click Next from the Blackberry Desktop Manager and follow the installation prompts.  

GMAIL app Install  
    1. After installing the browser, go to http://gmail.com/app.  
    2. Click on "Open".  
    3. Message opens up "The application Opera Mini is attempting to invoke the browser to
view m.google.com. Would you like to allow this?"   
    4. Click Yes.  
    5. Click on Download.  

Google SYNC (Contacts and Calendar)  
    1. Go to http://m.google.com/sync  
    2. Click on "Install Now".  
    3. Follow any further instructions.  

  Blackberry - Data Connectivity (without BIS services) MMS Receive only 

  

*NOTE: This is a ZIP file. You will have to extract in order to use with BB DM.* CLICK HERE
TO DOWNLOAD ZIP FILE

  

Other's charge for this file but here we offer it for free. Confirmed receiving picture text
messages and default browser working. No need for third party opera....!
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1) ENABLE SERVICE BOOK COMPLETE BACKUP / OVER WRITE / RESTORE on the
Device, like this:

  

 

  

a) On your device, go to Options -> Advanced Options -> Service Books hold Alt and hit
{S}{B}{E}{B} let go of alt and it should show a message about how legacy service books are
enabled.

  

 

  

2) BACKUP EXISTING SERVICE BOOKS

  

 

  

a) Hook up the phone to the laptop/desktop

  

 

  

b) Open Blackberry Desktop Manager -> Backup/Restore -> Advanced

  

 

  

i) On the right side, scroll down to Service Books, then press the <<
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ii) Click on Save, and save them some place just in case

  

 

  

3) WRITE NEW SERVICE BOOKS TO DEVICE

  

 

  

a) First, clear your service books by scrolling down on the right side, high light Service Books,
then press Clear

  

 

  

b) Check your device now (Options -> Advance Options -> Service Books)

  

 

  

i) If there is anything left besides something that mentions TCP/IP or Browser, delete those also

  

 

  

c) Open BB DM, go to Backup/Restore -> Advanced -> Left Window -> File -> Open -> select
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the service book file you downloaded, then the >> button to move it over. A pop-up will ask if
you want to over-write. Say "Yes." *After Load Disconnect Phone from Computer*

  

 

  

e) Go to advanced settings -> browser and change the hot spot to “NET Browser”.

  

 

  

g) If you do not get the “NET Browser” option restart and try again. You will need to restart with
step 1 (holding down alt + SBEB).

  

 

  

*On the Blackberry Device do the following:

  

 

  

*Go to Options

  

 

  

*Go to Advanced Options
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*Go to TCP/IP

  

 

  

*Be sure there is a check mark for APN Settings Enabled

  

 

  

*For the APN type “simple”

  

 

  

*Click on the Blackberry menu button and choose “Save"

  *NOTE: This is a ZIP file. You will have to extract in order to use with BB DM.* CLICK HERE
TO DOWNLOAD ZIP FILE

         LG (Generic)
  Internet Setup  
    1. Select Menu.  
    2. Select Settings.  
    3. Select Connection.  
    4. Select Network Profile.  
    5. Select Network Profile.  
    6. Enter the following information:                    
    -  Connection title: simple web  
    -  Auth: [None]  
    -  User name: [empty]  
    -  Password: [empty]  
    -  APN: simple  
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Browser Setup  
    1. Select Menu.  
    2. Select Media Net (if At&t).  
    3. Select Browser Settings.  
    4. Select Accounts.  
    5. Select Options.  
    6. Select New.  
    7. Enter the following details:                    
    -  Acct Name: Simple Web  
    -  Homepage: [User Preference]  
    -  Connection Type: TCP without proxy  
    -  Security: Non-Secure  
    -  Time out: 150  
    -  Network profile: Simple Web  
    -  Click Save  
    -  Check the box next to Simple Web  

    

MMS setup  
    1. Select Messages.  
    2. Select Message Settings.  
    3. Select MMS.  
    4. Select message Center.  
    5. Select Options.  
    6. Select New.  
    7. Enter the following information:                    
    -  Name: Simple MMS  
    -  MMSC URL: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  
    -  MMSC Proxy: 0.0.0.0  
    -  MMSC Port: 80  
    -  Connection Mode: TCP w/o Proxy  
    -  Network Profile: Simple Web  
    -  Click Save  
    -  Select Activate  

    

         LG KP500
  Internet Setup  
    1. Select Menu.  
    2. Select Settings.  
    3. Select Connection.  
    4. Select Access points.  
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    5. Add profile.  
    6. Connection title enter: Simple Mobile  
    7. Bearer: GPRS  
    8. Authentication: PAP  
    9. Username: NONE  
    10. Password: NONE  
    11. APN' enter: simple  
    12. Connection title enter: Simple Mobile  
    13. Save'.  
    14. Back to Connectivity.  
    15. Internet profiles.  
    16. Add profile.  
    17. Title enter: Simple WEB  
    18. Use proxy: On  
    19. Proxy server address: 216.155.165.050  
    20. Proxy server port: 8080  
    21. Access point: Simple mobile  
    22. Save  
    23. Go to the internet.  
    24. Settings.  
    25. Profiles.  
    26. Add profile  
    27. Title: Simple  
    28. Internet profile  
    29. SimpleWEB  
    30. Save.  
    31. Activate Simple WEB.  

MMS Setup  
    1. Select Menu.  
    2. Select Settings.  
    3. Select Connectivity.  
    4. Select Internet profiles.  
    5. Add profile.  
    6. Title: Simple MMS  
    7. Use proxy: On.  
    8. 216.155.165.050  
    9. Proxy server port: 8080  
    10. Access point: Simple Mobile  
    11. Multi msg center  
    12. Add center  
    13. Title: Simple MMS  
    14. MMSC URL: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  
    15. MMS profile  
    16. Simple MMS  
    17. Save, then press "Yes" to activate.  
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  Samsung Gravity and Most Samsung Devices - Internet and MMS Setup
  Internet/WAP Setup  
    1. Enter *#87927#.  
    2. Enter the appropriate settings as shown below:                    
    -  Set Name: simplemobile  
    -  Access Name: simple  
    -  Auth type: None  
    -  Protocol: HTTP  
    -  Home URL: http://www.google.com  
    -  Proxy: 0.0.0.0  
    -  Port: 0  
    -  Linger time: 300  
    -  Select Save  

    

MMS Setup  
    1. Enter *#87667#.  
    2. Enter the appropriate settings as shown below:                    
    -  Set Name: simplemms  
    -  Access Name: simple  
    -  Auth type: Secure  
    -  Protocol: HTTP  
    -  Home URL: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  
    -  Proxy: 0.0.0.0  
    -  Port: 0  
    -  Linger time: 300  
    -  Select Save  

    

  Samsung Behold (Highlight, Memoir & Solstice) - Internet and MMS Setup
  Internet  
    1. *#6984125*#  
    2. In the Admin setting.  
    3. Network & call settings.  
    4. Connections.  
    5. Network profiles menu, you will need to delete the DM Profile and the TMO_DS profile.  
    6. Name: SimpleMobile  
    7. APN or Access Point : simple  
    8. Proxy: 216.155.165.050  
    9. Home URL: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  
    10. Port: 8080  
    11. Linger Time: 3003  
    12. Auth Type: Not Set or empty  

 11 / 21



APN and MMS Settings for SimpleMobile

    13. Internet (you will need to edit the Browser Profile).  

MMS (you will need to edit the MMS profile)  
    1. Name: Simple MMS  
    2. Access name: simple  
    3. Proxy: 216.155.165.050:8080  
    4. Home URL: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  

  Samsung A-Series Phones - Internet and MMS Setup
  Internet  
    1. Menu.  
    2. Settings.  
    3. Application Settings.  
    4. Browser Settings.  
    5. Options.  
    6. New.  
    7. Set Name: Simple Web  
    8. Access Name: simple (All Lowercase)  
    9. Auth Type: none  
    10. User ID: blank  
    11. Password: blank  
    12. Protocol: HTTP  
    13. Home URL: http://www.google.com/  
    14. Proxy Address: 216.155.165.050  
    15. Port: 8080  
    16. Linger Time: 3003  
    17. Save  
    18. Highlight Simple Web and Save.  

MMS  
    1. Menu.  
    2. Settings.  
    3. Application Settings.  
    4. Messaging Settings.  
    5. Multimedia Message.  
    6. Multimedia Message Profiles.  
    7. Options.  
    8. New.  
    9. Set Name: Simple MMS  
    10. AcAuth Type: Secure  
    11. User ID: blank  
    12. Password: blank  
    13. Protocol: HTTP  
    14. Home URL: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  
    15. Proxy Address: 216.155.165.050  
    16. Port: 8080  
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    17. Linger Time: 3003  
    18. Save  
    19. Highlight Simple MMS and Save.  

  Samsung T-Series Phones - Internet and MMS Setup
  Internet Setup  
    1. Enter *#87927#  
    2. Name: Simple Web  
    3. APN: simple  
    4. Auth Type: none  
    5. Username: blank  
    6. Password: blank  
    7. Protocol: HTTP  
    8. Home URL: http://www.google.com/  
    9. Proxy Address: 216.155.165.050  
    10. Proxy Port: 8080 (If there is no field for the port add ":8080" at the end of the proxy
address)   
    11. Linger Time: 3003  
    12. Save  

MMS Setup  
    1. Enter *#87927#  
    2. Select MMS.  
    3. Name : Simple MMS  
    4. APN: simple (All lowercase)  
    5. Auth Type: Secure  
    6. Username: blank  
    7. Password: blank  
    8. Protocol: HTTP  
    9. Home URL: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  
    10. Proxy Address: 216.155.165.050  
    11. Proxy Port: 8080 (If there is no field for the port add ":8080" at the end of the proxy
address)   
    12. Linger Time: 3003  
    13. Save  

Alternative Internet Setup  
    1. Enter *#87927#  
    2. Select Profile Settings.  
    3. Choose an empty profile to edit the settings on, usually Profile 2.  
    4. Name : Simple Web  
    5. Home URL: http://www.google.com/  
    6. Proxy Enabled.  
    7. Auth Type: none  
    8. Username: blank  
    9. Password: blank  
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    10. Protocol: HTTP  
    11. Select GPRS Settings  
    12. Proxy Address: 216.155.165.050  
    13. Proxy Port: 8080  
    14. APN or Access Point: simple (All lowercase)  
    15. Save  
    16. Save again.  
    17. Go back to the screen where it says Current Profile and Profile Settings.  
    18. Select Current Profile.  
    19. Highlight Simple Web then press save.  

Alternative MMS Setup  
    1. Enter *#87667#  
    2. Select Profile Settings.  
    3. Choose an empty profile to edit the settings on, usually Profile 2.  
    4. Name : Simple MMS  
    5. Home URL: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  
    6. Proxy Enabled.  
    7. Auth Type: Secure  
    8. Protocol: HTTP  
    9. Username: blank  
    10. Password: blank  
    11. Select GPRS Settings  
    12. Proxy Address: 216.155.165.050  
    13. Proxy Port: 8080  
    14. APN or Access Point: simple (All lowercase)  
    15. Save  
    16. Save again.  
    17. Go back to the screen where it says Current Profile and Profile Settings.  
    18. Select Current Profile.  
    19. Highlight Simple Web then press save.  

  Sciphone (iPhone clone) - Internet and MMS Setup
  Internet Setup  
    1. Select Menu, Services, Data Account, and then select GPRS.  
    2. Select the first profile (China Mobile) and then select Edit.  
    3. Enter the appropriate settings as shown below:                    
    -  Name: simpleweb  
    -  Access Point (APN):simple  
    -  Connection Type: http  
    -  User Name: none  
    -  Password: none  

    
    -  Select Options and then select Done.  
    -  Select Services, WAP, and then select Settings.  
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    -  Select Edit Profile, SIM 1, and then Edit the first profile in the list.  
    -  Enter the appropriate settings as shown below:                    
    -  Name: simpleweb  
    -  Homepage:http://www.google.com  
    -  Data Account: simpleweb  
    -  Connection Type: http  
    -  **The following settings may not appear**  
    -  Proxy: 0.0.0.0  
    -  Port: 80  
    -  User Name: none  
    -  Password: none  

    

MMS Setup  
    1. Select Messages and then select Message Settings.  
    2. Select Server Profile, and then Edit the first profile in the list.  
    3. Enter the appropriate settings as shown below:                    
    -  Name: simpleweb  
    -  Homepage: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  
    -  Data Account: simpleweb  
    -  Connection Type: http  
    -  **The following settings may not appear**  
    -  Proxy: 0.0.0.0  
    -  Port: 80  
    -  User Name: none  
    -  Password: none  

    
    -  Select Options and then select Done.  
    -  Highlight the new profile and then select Activate.  

  Nokia Devices
  Generic Internet Setup  
    1. From the main menu select Settings.  
    2. Select Configuration settings.  
    3. Select Personal configuration settings.  
    4. Select Add New.  
    5. Select Services (or Web).  
    6. Select Account name.  
    7. Enter Simple.  
    8. Select OK.  
    9. Select Homepage and enter: http://www.google.com  
    10. Select OK twice.  
    11. Leave the Username and Password blank.  
    12. Select Access point settings.  
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    13. Select Proxy.  
    14. Select Disable.  
    15. Select OK.  
    16. Select Proxy address.  
    17. Enter 0.0.0.0  
    18. Select OK.  
    19. Select Proxy Port.  
    20. Enter 8080 and then select OK.  
    21. Select Data bearer.  
    22. Select GPRS and then select OK.  
    23. Select Bearer settings.  
    24. Select GPRS access point.  
    25. Enter simple as the access point and then select OK.  
    26. Select Authentication.  
    27. Select Normal and then select OK.  
    28. Leave the Username and Password blank.  
    29. Select Back twice.  
    30. Select the Simple profile.  
    31. Select Options.  
    32. Select Activate Service Settings.  
    33. Press the red End key to return to the home screen.  

  Nokia 5230
  Internet Setup  
    1. Menu.  
    2. Settings.  
    3. Connectivity.  
    4. Destinations.  
    5. Internet.  
    6. Options.  
    7. New access point.  
    8. Tap on No.  
    9. Tap on Packet data.  
    10. Tap on the Text field.  
    11. Enter Simple Web and then tap on the Green check mark.  
    12. Tap on OK.  
    13. Highlight the Simple Web and then tap on Options.  
    14. Tap on Edit.  
    15. Tap on Access point name.  
    16. Enter "simple" and tap on the Green check mark.  
    17. Tap on OK.  
    18. Tap on Homepage.  
    19. Enter http://www.google.com/ and then tap on the Green check mark.  
    20. Tap on OK.  
    21. Tap on Options.  
    22. Tap on Advanced settings.  
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    23. Tap on Proxy server address.  
    24. Enter 216.155.165.050 and tap on the Green check mark.  
    25. Tap on OK.  
    26. Tap on Proxy port number.  
    27. Enter 8080 and tap on the Green check mark.  
    28. Tap on OK.  
    29. Tap on Back until you reach the Main menu screen.  
    30. Tap on the Internet icon.  
    31. Tap on the Web icon.  
    32. Tap on Options.  
    33. Tap on Settings.  
    34. Tap on General.  
    35. Tap on Access point.  
    36. Tap on Internet and tap on Options.  
    37. Tap on Select access point.  
    38. Highlight Simple Web and then tap on OK.  
    39. Your manual internet will now be configured and set as default.  

MMS Setup  
    1. Menu.  
    2. Settings.  
    3. Connectivity.  
    4. Destinations.  
    5. Multimedia msg.  
    6. Options.  
    7. New access point.  
    8. Tap on No.  
    9. Tap on Packet data.  
    10. Tap on the Text field.  
    11. MMS.  
    12. Enter Simple and then tap on the Green check mark.  
    13. Tap on OK.  
    14. A new Access point is added.  
    15. Highlight the new access point and then tap on Options.  
    16. Tap on Edit.  
    17. Tap on Access point name.  
    18. Enter "simple" and tap on the Green check mark.  
    19. Tap on OK.  
    20. Tap on Homepage.  
    21. Text field.  
    22. Enter: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  
    23. Tap on OK.  
    24. Tap on Options.  
    25. Tap on Advanced settings.  
    26. Tap on Proxy server address.  
    27. Enter 216.155.165.050 and tap on the Green check mark.  
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    28. Tap on OK.  
    29. Tap on Proxy port number.  
    30. Enter 8080 and tap on the Green check mark.  
    31. Tap on OK.  
    32. Tap on Back until you reach the Main menu screen.  
    33. Tap on the Messaging icon.  
    34. Tap on Options.  
    35. Tap on Settings.  
    36. Tap on Multimedia Message..  
    37. Tap on Access point.  
    38. Tap on MMS.  
    39. Tap on Simple OK.  

  HTC Dash (Windows Phone & Windows Mobile) - Internet Setup
  Internet Setup  
    1. Click on Start.  
    2. Select Settings.  
    3. Select Connections.  
    4. Select GPRS (DELETE ALL T-MOBILE OPTIONS).  
    5. Select New and enter the following information:                    
    -  Name: Simple  
    -  Connect to: Internet  
    -  Access point name: simple  
    -  Username: Blank  
    -  Password: Blank  
    -  Primary dns: Blank  
    -  Secondary dns: Blank  
    -  IP address: Blank  

    
    -  Press Done.  
    -  Start.  
    -  Internet Explorer.  
    -  Menu.  
    -  Tools.  
    -  Options.  
    -  Connections.  
    -  "Automatically Detect Settings" should be Checked.  
    -  Done.  

  HTC HD2 - Internet and MMS Setup
  Internet Setup  
    1. From the home screen scroll to Settings.  
    2. Select Wireless Controls.  
    3. Select Menu on the bottom right.  
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    4. Select Connections.  
    5. Select Advanced.  
    6. Select "Select Networks".  
    7. Select New.  
    8. Enter "Simple Mobile" in the field.  
    9. Select Modem.  
    10. Select New.  
    11. Enter "Simple Web" in the field - enter a name for the connection.  
    12. Select "Cellular Line (GPRS)" in the field "Select a Modem".  
    13. Enter "simple" in the field "Access point name".  
    14. Leave User name/Password/Domain blank.  
    15. You should now see a black dot in front of Simple Web. Select OK on the top right.  
    16. Ensure "Simple Mobile" is selected for both drop down menus.  
    17. Your internet is now configured.  

MMS Setup  
    1. From the home screen select the "Messages" application.  
    2. Select Menu in the bottom right.  
    3. Select Settings.  
    4. Select Options.  
    5. Select Menu in the bottom right.  
    6. Select MMS Server.  
    7. Select New.  
    8. Enter the following:                    

  
    -  Name: Simple MMS  
    -  IP Address: 216.155.165.050  
    -  Port number: 8080  
    -  Server Address: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  
    -  Connect via: Simple Web  
    -  Message size limit: 1024 KB  

    
    -  Select and hold down Simple MMS.  
    -  SSelect Set as Default.  
    -  There should be a green dot marked on the right of Simple MMS.  
    -  Your MMS is now configured.  

  HTC G1 and G2
  Internet Setup  
    1. Press the menu button (on front of phone).  
    2. Tap Settings.  
    3. Tap Wireless Controls.  
    4. Tap Mobile Networks.  
    5. Tap Access Point Names.  
    6. Press the menu button.  
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    7. Select New APN.  
    8. Enter the following details:                    
    -  Name: Simple  
    -  APN: simple  
    -  Proxy: 0.0.0.0  
    -  Port: 8080  
    -  Username: [empty]  
    -  Password: [empty]  
    -  Server: [empty]  
    -  MMSC: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  
    -  MMS Proxy: 0.0.0.0  
    -  MMS Port: 8080  
    -  MCC: [empty]  
    -  MNC: [empty]  
    -  APN Type: not set  

    

  Google Nexus One
  Internet Setup  
    1. Enter the following details:                    
    -  APN: Simple  
    -  Proxy: 216.155.165.50  
    -  Port: 8080  
    -  Username: not set  
    -  Password: not set  
    -  Server: not set  
    -  MMSC: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  
    -  MMS Proxy: 216.155.165.50  
    -  MMS port: 8080  
    -  MCC: 310  
    -  MNC: 260  
    -  Authentication type: PAP  
    -  APN Type: not set  

    

        Motorola RAZR v3 - Internet and MMS Setup
  WAP Setup  
    1. Enter the Main Menu.  
    2. Select Settings.  
    3. Select Web Access.  
    4. Select Web Sessions.  
    5. Select New Entry.  
    6. Enter the following information:                    
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    -  Name: Simple  
    -  Homepage: [Up to the customer]  
    -  Proxy 1: 0.0.0.0  
    -  Port 1: 8080  
    -  Domain 1: [empty]  
    -  DNS1: [empty]  
    -  DNS2: [empty]  
    -  GPRS APN: simple  
    -  Username: [empty]  
    -  Password: [empty]  

    
    -  Select Done.  
    -  With Simple highlighted, select Options Set as Default.  

MMS Setup  
    1. Enter the Main Menu.  
    2. Select Messaging.  
    3. Select Options.  
    4. Select Setup.  
    5. Select Message Setup.  
    6. Select Multimedia Message Setup.  
    7. Select Server Info.  
    8. Select Options.  
    9. Select New.  
    10. Enter the following details:                    
    -  Service Name: Simple MMS  
    -  Servername: http://smpl.mms.msg.eng.t-mobile.com/mms/wapenc  
    -  Web Session Name: select Simple  

    
    -  Select Done.  
    -  Select simple mms and there will be a check next to it that indicates it will be using that
mms profile.   
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